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AutoSPRINK VR7 New Features 
 

AutoSPRINK Program Features 

Licensing 
Bronze (AQ) license features are available for users with non-licensed versions of 
AutoSPRINK (4/19/07). 

RealDWG 2008 
RealDWG 2008 has been implemented to support unicode and compatibility (8/13/07). 

Crystal Reports XI 
These reports have been implement in to the AutoSPRINK program for unicode support 
(9/24/07). 

Menu Modifications 

Bronze and Silver Level Menu Modifications 
A variety of items have been disabled and activated in the Settings (including the 
Fabrication Standards page), Parts Database, View, Tools, Commands, Hydraulics, and 
Listing menus (9/19/06). 

Gold Level Menu Modifications 
A variety of items have been activated in the Actions, Edit, Snaps, Commands, 
Hydraulics, and View menus (9/7/06). 
 

Bronze License New Features: 
 

• All items under the Commands and Parts Database menus are now activated 
and available for use (8/31/06). 

 
• AutoCAD drawings can now be imported and exported (8/31/06). 

 
• Stock Listing is now available (8/31/06). 

 
• The 3-D option for the Remote Area Boundary tool is now available (8/31/06). 

 
• The Cleanup Node Tags option under the Hydraulics menu is now disabled 

(8/31/06).  
 

• Copy Bitmap and Paste Bitmap under the Edit menu are now both available 
(2/14/07). 

 
• Batch Print under the File menu is now disabled (2/14/07). 

 
• Excel Spreadsheets have been removed from this license (2/14/07). 
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• The Link tool has been removed from the Bronze and Silver levels (2/14/07).  

 
• Command Dialogs under the Settings menu has been removed from the Bronze 

and Silver levels (2/14/07). 
 
• Camera tools have been removed from the Bronze and Silver levels (2/14/07). 

 
• The Clipping Planes tool has been removed from the Bronze, Silver, and Gold 

levels (2/14/07). 
 

• All greyed out tools (due to licensing limitations) have been removed from the 
Bronze and Silver license levels (2/14/07). 

 
• The right-click Get Defaults from Selection command for Beams has been 

disabled (3/23/07). 
 

• The Modify Pipes tool has been removed from the Bronze license level (2/14/07). 
 

• Calculations for Max and Adjusted Loads are not available for the Sway Brace 
(3/23/07). 

 
• The Riser Nipple command has been removed. The Riser Nipple button has 

been replaced with the Pipes to Target Pipes command (4/30/07). 
 

• Sway Brace, Offset Move/Copy, Rotate, Align Labels with Parent Elements, and 
the Column Grid Wizard are all added menu items (5/4/07).   

 
• The Tree and Grid Wizards have been added to the Wizards menu (8/13/07). 

 
• The Remote Area function is now available in the Hydraulics menu and in all 

applicable Wizards (3/4/08). 
 

Silver License New Features: 
 

• Selection Cursor has been added to the Tools menu (2/14/07). 
 
• The Quick Data Editors submenu has been removed from the Silver license 

(2/14/07). 
 

• The right-click Get Defaults from Selection command for Beams has been 
disabled (3/23/07). 

 
• Calculations for Max and Adjusted Loads are not available for the Sway Brace 

(3/23/07). 
 

• The Convert Lines to Pipes command has been added to the Commands menu 
(4/30/07). 
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• Sway Brace, Align Labels with Parent Elements, and Report Printer Setup are all 

added menu items (5/4/07). 
 

• The Remote Area function is now available in the Hydraulics menu and in all 
applicable Wizards (3/4/08). 

 

Tools Menu 

Picture Tool  
Now automatically captures the current scene (current drawing) in the Picture tool 
Properties page (9/1/06). 
 

Pipe 
• If a Drop pipe is created, the pipe cut length property is defaulted to a manual 

takeout of 0.0 (4/12/07). 
 
• The KWH, or DR 9 /DR 11 pipe type has been added to the pipe material list 

(7/19/07). 
 

• The Match Pipe Ends to Fittings, Delete Pipes and Close Gaps, and Copy and 
Move Along a Vector actions have been removed from the contextual (right-click) 
menu, and the Match Elevation and Match Properties actions have been added 
(11/5/07). 

 

Flex Drop Tool 
This tool has been added to the Fitting submenu (7/25/07). 
 

Pipe/Sprinkler Tool: 
 

• Simple Interface – A left mouse click brings up a flyout listing a variety of sizes 
(9/1/06).  

 
• Elevation Lock has been applied to this tool (10/5/06). 

 

Sway Brace Tool 
This tool has been added to the tools menu (11/27/06). 
 
Sprinkler 
The Copy and Move Along a Vector actions have been removed from the contextual 
(right-click) menu, and the Match Elevation and Match Properties actions have been 
added (11/5/07). 
 
Fixed Flow Devices 
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The hydraulic calculations at all fixed flow devices (including Hydrant and Nozzle) now 
try to meet the minimum pressure if this setting is non-zero. This should only make a 
difference if Minimum Pressure is greater than the demand pressure at that node 
(12/10/07). 

Areas Submenu 
There is now an Area Placement Options dialog that appears allowing users to set the 
elevation when placing an occupancy and system area (1/25/07).  

Mechanical Cross 
This new fitting has been added to the Fitting submenu. 
 
Properties 
Fitting types will filter to only show existing types (12/3/07). 
 

Listing Menu 

Miscellaneous Pipes  
When creating pipelines and make-ons, miscellaneous pipes now are considered as 
“others” and not Cross Mains (9/6/06). 

Pipelines 
 

• Type Sequence – Specific to creating pipelines and make-ons, there are now 
separate number sequences when using a different prefix for Branchlines and a 
different prefix for Cross Mains (9/6/06).   

 
• Default Properties – There are now separate default properties for Lines, Mains, 

and Others (10/5/06). The default properties for Lines and Others are the same 
(11/28/06).  

 
• Line Label Placement – Multiple labels can now be placed on a pipeline 

(10/25/06). 
 

• Update Pipelines – This function is now available under the Finish menu in the 
Labels dialog on the Pipeline tab 11/28/06). 

 
• Option added on the Pipelines & Make-Ons dialog to preface segment 

designation with incremented pipeline label (3/1/07). 

Price Area Text Table  
This Graphic User Interface (GUI), including its Properties page has been altered to be 
more intuitive (10/6/06). 

Finish Menu 

Column Labels 
There is a new option to include a column number at the top of each column (7/23/07). 



 8

 
Manufacturer Harmonizing 
This tool has been added to the Finish Menu (11/5/07). 
 

Actions Menu 

Cleanup Intersections  
• This command now checks for Smart Pipe color and valid pipe role in the Simple 

Interface (9/6/06). 
 

• This command now deselects all selected alerts before running (11/15/07). 
 

Toolbars 

Route Pipe Toolbar Button (Simple Interface)  
Now brings up the Route Pipes Properties dialog box once a route pipe size is selected 
first from the flyout (9/1/06). 

Clipping Slider 
The Clipping Slider toolbar has been added to the AutoSPRINK program (7/20/07). 

Parts Tree 
The Get Defaults from Selection command has been added to the right click menu in 
the Select tab. 

Modifications 
• Silver, Gold (Simple Interface), and Platinum (Simple Interface) Finish Toolbar 

Modifications – Minor modifications have been made to the Finish Toolbar 
(9/11/06). 

 
• Pipe Properties Toolbar Modifications  

Changes have been made to the Pipe Properties toolbar for Bronze, Silver and 
Gold/Platinum (Simple Interface) levels (9/12/06). 

 
• The layout for the Modify Selected Pipes toolbar has changed (2/28/07).  

 
• The Pipe Elevation Lock on the Pipe toolbar has an added option to set the 

finish floor elevation (8/14/07).  
 
• Tool Tips have been added to the fly-out toolbar options in the Simple 

Interface for Gold and Platinum levels, and in the Silver and Bronze levels 
(9/24/07). 

 
• Actions Toolbar  

• Changes have been made to the Actions toolbar for the Bronze, Silver and 
Gold (Simple Interface) levels (9/12/06). 
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• Changes have been made to the Platinum license Actions toolbar (Auto Clip, 
Foreground, and Background clip buttons removed. Wizards flyout button 
added.) (3/27/07) 

 
• Auto Draw Toolbar 

The Sway Brace tool button has been added to the toolbar (3/27/07). 
 

 

Pipe Groups 
 

• C (copper), P (plastic), and G (grooved pipe) have been added to all Pipe Group 
lists (9/1/06).  Pipe Group W now has Schedule 40 as the default pipe material 
for size 1 (10/3/06). 

 
• Typical (T) pipes automatically omit segment labels. Non-typical pipes retain their 

segment designation (11/16/06). 
 

Settings Menu 

Get Defaults from Selection  
• Now allows user to match the properties of a new element(s) with those of an 

element(s) used in previous versions of AutoSPRINK (9/5/06). 
 

• When right-clicking on a sprinkler in a drawing, Get Defaults From Selection will 
also set the wizard sprinklers to the selected properties (5/1/07). 

Fabrication Standards 
• In the Special Conditions section of the Fabrication Standard dialog, (Pipes tab) 

Limit Type List is the only option defaulted to selected. The two “Force Fittings” 
options are defaulted to not selected (1/9/07). 

 Limit Type List has been removed from this dialog (3/23/07). 
 

• There are new default options for the Pipeline tab in both the Simple and 
standard interfaces. Two new options have been added to the ‘Line Ownership’ 
area of the Pipeline tab (1/8/07). 

 
• Assign Pipe Roles has been removed from the Pipes tab of the Standard 

Interface Fabrication Standards dialog (3/23/07). 
 

• In the Smart Pipe section of the Simple Interface Fabrication Standards Pipes 
tab, text to define the pipes that override above defaults has been added 
(2/23/07). 

 
• The Minimum Allowable Pipe Lengths section of the Pipe & Hanger Lengths 

tab has been altered with different cut length attributes (4/19/07). 
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• The default settings for the minimum distance an outlet can be placed from the 
end of a pipe and for the Pipe Cut Lengths section of the Pipe & Hanger 
Lengths tab have been changed (11/2/07). 

 
• The default settings have been changed in the Pipe Sizing tab (11/2/07). 

 
• The option to include additional pipe sizes in the Pipe Sizing tab may not be 

unchecked in the Bronze or Silver licenses (11/2/07). 
 

• The Sway Brace tab has been added to the Fabrication Standards dialog 
(12/11/07). 

 
• Pipes will now show as a red circle when their Cut Length is too short based on 

the Fabrication Standards dialog (3/4/08). 
 

Speech Recognition  
• The Customize Speech Recognition dialog now has two property pages that are 

a part of the dialog (12/12/06). 
 
• There is now a Simple Interface Speech Recognition Configuration dialog which 

shows speech phrases for Smart Pipe voice commands (2/1/07). 
 

• Under the Edit Speech Recognition Command Phrases tab the command 
'ToolPipeContinuous' phrase was changed to Pipe (2/1/07). 

 
• After a profile is created, and OK is selected, the created profile is the one used 

from that point forward until changed by the user (1/8/07). 
 

• Speech recognition is now installed by default when using the Typical installation 
(11/5/07). 

 

Steel Details  
Labels can be placed on beams. Beam labels are now available on the Beam Properties 
page (9/1/06). 

Supply Properties  
The Location field has been added to this properties page (9/19/06). 

Typical Piping  
There is a now a capability on the Fabrication Standards Pipeline page to control the 
minimum number of pipes in a ‘Typical’ group (8/25/06). 
 

Smart Piping  
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• The Ignore Smart Pipe option is automatically activated when a user makes any 
change to a pipe’s properties. This option along with Ignore Smart Color has 
also been added to the last page of all Wizards (9/19/06). 

 
• The Modify Pipe tool now checks for the status of Ignore Smart Pipes (12/1/06). 

 
• Undo elements have been added to account for adding a pipe and altering a 

pipe’s settings (12/13/06). 
 

• If a pipe drawn by a user is a Feed Main and is collinear with a Cross Main, the 
pipe will be a Cross Main (3/2/07). 

 
• “Set Ground Start z” is a user-defined option which has been added to the 

Simple Interface Pipes page that allows users to set an underground pipe 
elevation (5/23/07). 

 

Settings Files 
The four settings files distributed with AutoSPRINK have been updated (9/19/07). 

File Menu 

Simplified Stock Listing 
There is now a Simplified Stock Listing license. The two-letter code is ‘SS’ (1/9/07). 

Source Control 
This menu item allows for version control of drawing and other files (1/5/07). 

Hydraulic Reports  
 

• Separate Job Names for Remote Area – A Job Suffix field has been added to the 
Hydraulic Report for each boundary type (9/19/06). 

 
• When generating and previewing report data, the program checks for any errors. 

If any errors are detected, they will force the Hydraulic Calculation Messages 
dialog box to open on the screen (8/31/06).  

 
• There is now an NFPA-style format Hydraulic report available. This is an updated 

format (font size, information, and style is different from the simplified format) 
(12/1/06). 

 
• The text on the Hydraulic Graphs has been shifted to not obscure the curve 

points (2/23/07). 

Stock Listing Reports  
• There are limited reports available under Simplified Stock Listing. 

The default Report Options, Printing Options, Fabrication Options, Export 
Report(s) buttons are all non-user accessible and Pipe Sticks options are non-
user accessible in the Simplified Stock Listing (1/9/07).  
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 An issue with the Threaded Branch Line Report (by size) having no data in it has 

been resolved (9/4/07). 
 

• Fittings descriptions on the reports are now all spelled out completely.  They are 
no longer abbreviated (9/24/07). 

 
• An issue where the pipe sizes did not show for the Cut Pipe Report in the Stock 

Listing Reports when “Text Only” was selected has been resolved (11/15/07). 

AutoSave  
When selecting the Explore Folder button on the AutoSave dialog, the AutoSave dialog 
box will now close before Windows Explorer opens (12/1/06). 

Importing AutoCAD Drawings  
The Clean House functions Remove Illogical Elements and Discard Unreferenced 
Symbol Data are included during the final stage of the import process (12/1/06). 

Sway Brace Reports 
This option has been added to the Printing submenu. (11/27/06). 

Manufacturer Data Sheets  
This item has been added to the Printing submenu (9/27/06). 

Import / Export Submenu 
• The DWGDirect options have been removed from the Import and Export 

submenus (3/23/07). 
 

• The option to import a Tol-Brace output file has been added to the Import 
submenu (4/20/07). 

Parts Database Menu 

New Parts Added to Parts List  
The Lag Bolt and the Machine (Hex) Bolt have been added to the Parts Book. These 
items supersede the Lag Screw and the Hex Bolt from previous versions of the Parts 
Book (9/1/06). 

Material Lists  
This list gives the ability to filter parts based on user defined sets of Minimum, Standard 
or All parts. This list had been added to the Parts Database: Parts Book Quick Data 
Editors menu (10/25/06). 

Removed User Parts Item 
Generic has been removed from the Manufacturer’s list under Step 2 for defining a user  
part (1/9/07). 
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Manufacturer Editor 
A user can add a new manufacturer when adding a new part. The default manufacturer 
item code is 10000000 (9/18/07). 

User Description 
All full Description fields display the User Description, when one exists, including 
in the reports. The Parts List dialog is the one place where the User Description 
does not display (9/21/07). 
 
New Sizes Added to Database 
New sizes have been added to the Parts Database, including 3/8 x 2¾ (12/10/07). 

Hydraulics Menu 

Check Point Gauge  
Normal Gauge, Base of Riser, and In-Rack are three new options for Gauge Type for 
Reporting available on the Check Point Gauge Properties page (9/19/06). 

Remote Area Boundary 
There is now an Area Placement Options dialog that appears allowing users to set the 
elevation when placing a remote area boundary (1/25/07).  
 
Analysis Reports 

• The numbers listed in the Node Analysis tab in the Analysis Reports dialog 
now appear red if the pressure calculated is higher than the Minimum Flowing 
Sprinkler Pressure specified in the Hydraulics Calculations dialog (11/2/07). 

• The velocity numbers listed in the Pipe Analysis tab in the Analysis Reports 
dialog now appear red if the velocity calculated is higher than the Maximum 
Velocity specified in the Hydraulics Calculations dialog (11/2/07). 

 
System Optimizer 
The velocity numbers listed in the Pipe List section in the System Optimizer dialog now 
appear red if the velocity calculated is higher than the Maximum Velocity specified in the 
Hydraulics Calculations dialog (11/2/07). 

Commands Menu 

Divide Command  
Point elements created from this command are now considered children of the parent 
element. Snap points to a pipe based on snap point distance set in pipe properties have 
also been added (9/18/06). 

Convert Text Boxes to Text Lines 
This command has been added to the Commands menu (7/23/07). 

Element to Polytriangles  
This command was created to convert many quads and/or triangles into a single 
polytriangle (12/1/06).  
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Interference Checking 
• Beams and columns no longer appear in the list of sources for interference and 

their corresponding values are set to FALSE (1/8/07). 
 

• The checkbox “Show one alert per element” has changed to “Show one alert per 
pair of elements” (3/26/07). 

 

Sway Bracing 
• There now is an Assign Sway Brace Zone Elements dialog with an option to 

exclude all elements, other than pipes, from being assigned (1/10/07).  
 

• The Sway Brace Detail command has been added to the Sway Bracing 
submenu. This command adds a Sway Brace detail to a drawing (3/29/07). 

 
• The Sway Brace Zone Legend and the Sway Brace Tag have been added to the 

Sway Bracing submenu (5/1/07). 
 
Delete Pipes and Close Gaps 

• This command has been added to the Commands menu. 

Auto Draw Menu 

Connect Pipes to Sprinklers  
• The New Pipe Properties area of this command’s page has been modified 

(9/19/06). 
 
• Two new options have been added to this dialog under Connect Using: Flex 

Drop and Pipe to Flex Drop (2/11/08). 
 

• An error message will now appear when this function fails to make a connection 
(3/4/08). 

Easy Drop  
The Convert to Plug option on this dialog his option also adds a Reducer/Coupling (or 
Reducer/Adapter) automatically if needed (4/12/07). 

Arm Around Command  
 

• This command has been added to the Auto Draw menu. Features have been 
added to this command to ensure the correct proposal is performed when 
resolving any interference. All entered user modification will save when Done is 
clicked (10/25/06). 

Alerts Menu 

Load and Save Resolution Proposals  
These commands have been added to the Alerts menu. Alerts associated with elements 
that produced the proposal can now be loaded and stored (9/19/06). 



 15

Parts Tree Alerts Tab 
• The secondary location will display in the Alerts tab of the Parts Tree if the 

primary and the secondary location differ (5/3/07). 
 

• The camera or view will be focused on a specific alert when that alert is selected 
in the Alerts Tab of the Parts Tree (9/18/07). 

Alert Properties Page 
• A drop-down control list has been added to this page under the Capture Image 

column to allow user to change the Selected Note Image (2/6/07). 
 

• An Export checkbox has been added to this page allowing a user to export an 
alert note as a text box appearing next to the alert when exported to AutoCAD 
(3/26/07). 

 
• Show Top of Structure, Show Finish Floor, and Show Horizontal have been 

added to the Alert Properties page (8/7/07). 

Interference Checking 
This command has been added to the Alerts menu (3/26/07). 

Alert Resolution Proposal Manager 
This dialog (available only in the Platinum license) has been added to the Alerts menu 
(8/7/07). 

Alert Control 
This dialog (available only in the Platinum license) has been added to the Alerts menu 
and provides various alert settings options (3/26/07). 

Select Menu 

Selection Properties  
Properties tabs of multiple elements appear on one main Properties page. A Selection 
Properties tab has been added to the Properties page if multiple elements are selected 
(9/19/06). 

Wizards Menu 

3-Point System and Grid System 
• The Finish button has been added to each dialog for both Wizards (4/30/07). 
• The [Tab] key on a user’s keyboard can be used to access the Finish button on 

both of these Wizards (9/18/07). 

Advanced Drop Connect Wizard 
This wizard has been added to the Wizards menu (2/11/08). 
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Help Menu 

About AutoSPRINK  
• In the About AutoSPRINK dialog box, an ampersand has been added between 

patent numbers for easier viewing (1/8/07). 
• A swing joint command patent has been added to the About AutoSPRINK dialog 

box (7/23/07). 
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